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1. Introduction
1.1. Deployment Guide Overview
This SmartAudio deployment guide outlines the steps required for deploying a SmartAudio Matrix Switch.  To ensure 
successful deployment please read this document in full before proceeding with deploying the system.

While this document contains all the steps required, other information may be needed during the process.  Please visit 
dealers.SavantSystems.com for any additional information that is not found within this document.

1.2. Before You Begin
• Read through this document in its entirety
• Ensure that the following required items are available and on hand:

• Savant Host (HST-XXXX or SVR-XXXX)
• RacePoint Blueprint (da Vinci 5.2.3 or higher)
• Ethernet Network (Enterprise-grade network deployment)
• SmartAudio Matrix Switch (SSA-3220 or SSA-3220D)
• Source components to be used in the installation
• Control devices (iPads, iPhones, Savant or 3rd party remotes)
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2. Preparation for Deployment
Follow the steps outlined in this section to ensure that SmartAudio is deployed within a system for optimum 
performance.  Use this list as checklist to ensure that all steps are performed in order.

1. Perform a Site Survey
Before any system design or configuration is performed, we recommend that a site survey is conducted to ensure 
that the system can be installed within the environment.  Make note of the locations of the rooms, room names, and 
wiring distances.

2. Create a List of Devices
Before starting the deployment it is important to know what the sources, displays, and controllers will be.  This will 
speed up the process of designing and configuring the system.  Be sure to include the device type, and physical 
location in the list.

3. Record all Device Information
Before deploying it is recommended that all serial numbers, mac addresses, Savant IDs, and any other specific 
information is recorded.  This will allow for quick reference during deployment, installation, and in the future for 
troubleshooting.

4. Research all Device Specifications
Knowing the capabilities of the source, display, and switching components is important to ensure that they meet the 
A/V, and control requirements of the system.  Make note of control methods so that the highest level can be used.

Count the number of IR and RS-232 connections to be used, this will come in handy when choosing a Savant 
controller with the correct amount of control connections for the system.

5. Determine the Best Connection Type
Using the data collected in the Site survey, and device research, identify the best connection for the signal being 
used.

6. Configure System Control
Use Blueprint to layout, and configure the system.
See Deploying SmartAudio for configuration procedure.

7. Test the System Components
While this step may add time to the installation up front, it will save installing a device twice, should something not 
function correctly.  Once tested, keep all components of the system together so that they maintain the same 
functionality.
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3. SmartAudio Overview (SSA-3220/SSA-3220D)
3.1. Box Contents
(1) SSA-3220 or SSA-3220D

(1) Installation Kit (075-0075-xx):

(4) Phillips Screws for Brackets (M5 x 12MM Flat) (039-0034-xx)

(2) 2U Rack Mounting Brackets  (071-0113-xx)

(1) Power cord C13, (6 feet) (N. America) (064-0079-xx)
or appropriate international power cord

(1) Quick Reference Guide
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3.2. Specifications

EnvironmentalEnvironmental
Temperature 32° to 104° F  (0° to 40° C)
Humidity 10% to 80% Relative Humidity (non-condensing)
Cooling 5 cubic feet per minute (CFM) recommended.
Maximum BTUs 105 BTUs per hour
Dimensions and WeightDimensions and Weight
Height 3.46 in / 8.79 cm
Width 17.30 in / 43.94 cm
Depth 12.94 in / 32.88 cm
Weight 14.25 lb / 6.5 kg
Rack Space 2U
PowerPower
Input Power 100-240V AC, 50/60 Hz 1.5 Amp

(uses standard 3 prong IEC C14 connector)
Nominal Power 25 watts
Maximum Power 40 watts 
Operational ParametersOperational Parameters
Total Harmonic Distortion+Noise 
(THD+N) < 0.004 %, 20 Hz - 20 KHz

Dynamic Range 100 dB, A-weighted
Signal-to-Noise Ratio (SNR) >100 dB, A-weighted
Frequency Response 20 Hz - 20 kHz ( varies +/- 1.5 dB over this range)
Input Impedance 12 K Ohms
Volume Control per Channel + 10 dB to -117 dB in 0.5 dB increments
Trim -10dB to +10dB on every configured audio input
Mute Individual output channel mute when in processed mode.

Mono Configurable on every output pair. Each channel will output the combined 
input signal.

Seven-Band Equalizer (EQ) On a per channel basis; +/- 12 dB, 0.5 dB steps
Supported Sample Rates 44.1 kHz  |  48 kHz  |  96 kHz  @ 16-bit or 24-bit resolution
Output Delay Each Channel
(SSA-3220D Only) Adjustable from 0 to 85ms
Analog Output Voltage 2V RMS / 5V max
ComplianceCompliance
Safety and Emissions FCC Part 15  |  S Mark  |  CE Mark  |  C-Tick
RoHS Compliant
Supported Audio Output FormatsSupported Audio Output Formats
Audio Source Signal Audio Output Connector Type
16 Analog Stereo PCM Inputs 16 stereo outputs with RCA jack connectors, left and right

S/PDIF Inputs: 16 Digital Coax 
or 12 TosLink
—Select between Coax or 
TosLink (first 12 inputs)

S/PDIF outputs: Four digital coax outputs RCA jack connectors; 
Coax output level: 500 mV nominal into 75 ohms
—Individually selectable pass-through for each digital input
Note: A 2ch PCM signal is required in order for a digital source to use 
pass-through.

Auto-Conversion Converts Stereo Analog Audio to two-channel PCM S/PDIF (Coax only) or 
converts PCM S/PDIF Audio (Coax or TosLink) to Stereo Analog audio.

Minimum Supported Release:Minimum Supported Release:
da Vinci 5.2.3
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3.2.1. Rear Panel Capabilities
Rear Panel Capabilities and Connectors
The next figure shows the rear panel of an SSA-3220. The numbered callouts on the figure are explained in the next table. 

98 131211
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4
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1 2

Number Item Description

1 Digital Audio In (16)
Receives digital (PCM and encoded) signal from S/PDIF inputs: 16 Coax digital 
audio or 12 digital TosLink connections that are selectable for a total of 16 
digital audio inputs

2 Audio In (16) 16 analog audio inputs (16 right and 16 left RCA jacks)

3 Digital Audio In (12)
Receives digital (PCM and encoded) signal from S/PDIF Inputs: 12 TosLink 
digital audio or 16 Digital Coax connections that are selectable for a total of 16 
digital audio inputs

4 LAN RJ-45 Ethernet 10/100 base-T, auto-negotiating port with link/activity LEDs

5 Vents Provide Cooling

6 Audio Out (16) 16 analog Stereo line-level audio outputs (16 right and 16 left RCA jacks)

7 Digital Audio Out (4) S/PDIF Out: Four digital Coax audio outputs (RCA jacks) 

8 Link/Activity LED (1)
Green indicates an Ethernet link has been established.
Green flashing indicates Ethernet activity.
Off indicates an Ethernet link has not been established.

9 Speed LED (1) Green indicates an Ethernet speed of 100 Mb.

10 Debug / RS232 (1)
RJ-45 female-connector port
Typically used for debug or optionally use this serial port for control from a 
Savant controller or third party control box.

11 Fuse (1) 100-240V, 2.5A—Fast acting fuse. This is field-replaceable.

12 I/O (1)
On/Off switch
I is used to power the controller to the On state. 
O is used to power the controller off.

13 Input Power (1) 100-240V AC, 50/60 Hz, 1.5 Amp

SmartAudio 20: SSA-3220
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1 Digital Audio In (16)
Receives digital (PCM and encoded) signal from S/PDIF inputs: 16 Coax 
digital audio or 12 digital TosLink connections that are selectable for a total 
of 16 digital audio inputs

2 Audio In (16) 16 analog audio inputs (16 right and 16 left RCA jacks)

3 Digital Audio In (12)
Receives digital (PCM and encoded) signal from S/PDIF inputs: 12 
TosLink digital audio or 16 digital Coax connections that are selectable for 
a total of 16 digital audio inputs

4 LAN RJ-45 Ethernet 10/100 base-T, auto-negotiating port with link/activity LEDs

5 Vents Provide cooling

6 Stereo Out (16) 16 Stereo line-level audio outputs (16 right and 16 left RCA jacks)

7 Digital Audio Out (4) S/PDIF Out: Four digital Coax audio outputs (RCA jacks) 

8 Link/Activity LED (1)
Green indicates an Ethernet link has been established.
Green flashing indicates Ethernet activity.
Off indicates an Ethernet link has not been established.

9 Speed LED (1) Green indicates an Ethernet speed of 100 Mb.

10 Debug / RS-232 (1)
RJ-45 female-connector port
Typically used for debug or optionally use this serial port for control 
from a Savant controller or third party control box.

11 Fuse (1) 100-240V, 2.5A—Fast acting fuse. This is field-replaceable.

12 I/O (1)
On/Off switch
I is used to power the controller to the On state. 
O is used to power the controller to the Off state.

13 Input Power (1) 100-240V AC, 50/60 Hz, 1.5 Amp
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3.2.2. Front Panel Capabilities

1 2 3

4

1 Reset (hole) Press & Hold the reset button for 5+ seconds.
Resets to static IP address.

2 Power 
(LED)

Green indicates the system has adequate power and is operating normally.
Red indicates the system is in stand-by mode. In standby most of the Controller circuitry  
is powered down.
Off indicates that the system is getting no power.

3 Status 
(LED)

Green indicates the host has established communications with the embedded system.
Green flashing indicates the embedded system is ready, but no communication has 
been established with the host.
Off indicates the embedded processor is resetting or is powered up; and is booting the 
embedded firmware.
Red indicates the host has determined the firmware needs to be updated, but a problem 
occurred during the process that will initiate a reset.
Red flashing indicates the embedded firmware is running, but has not received a 
DHCP IP Address.
Amber indicates the host is currently updating the embedded firmware.
Amber flashing indicates the embedded system has a valid link-local IP Address, and 
is waiting to connect to the host.
Hardware Failure: If a hardware failure occurs, the Status LED indication will be 
interrupted every three seconds with a solid red indication. For example, if the LED is 
flashing green when a hardware failure occurs, the LED will alternate between flashing 
green and solid red at three-second intervals.

4
On/Off 
button 
(hole)

Insert pin into hole for about 10 seconds to place in standby mode. The Power button 
turns red. Insert the pin again for about one second to take the system out of standby 
mode. The power button turns green. The I /0 power switch on the back of controller 
must be On (I) to enable this function. To turn the power off for the entire system, use the 
switch on the rear panel.
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4. IP Network Requirements
Savant requires the use of business class/commercial grade network equipment throughout the network to ensure the 
reliability of communication between devices.  These higher quality components also allow for more accurate 
troubleshooting when needed.

Connect all Savant devices to the same local area network (LAN), virtual local area network (VLAN), or subnet as the 
host.  Savant recommends not implementing any type of traffic or packet shaping in your network topology for the 
Savant devices as this may interfere with performance.

Network Configuration
To ensure that the IP address will not change due to a power outage, a static IP address or DHCP reservation should be 
configured.  Savant recommends using DHCP reservation within the router.  By using this method, static IPs for all 
devices can be managed from a single UI avoiding the need to access devices individually.

Setting DHCP reservation varies from router to router.  Refer to the documentation for the router to configure DHCP 
reservation.

Matrix IP Settings
Use the Network tab within the Web UI.  See Appendix B - Retrieving and Setting IP Address for details.

Network Changes
The SmartAudio matrix requires rebooting after connecting to a new network, changing routers, or if the IP address 
range is changed in the current router.

To reboot the matrix:

• Cycle Power
Disconnect the controller from the AC power source for 15 seconds and then reconnect.

• Hot Plug the Ethernet (LAN) Connection
Disconnect the Ethernet (LAN) connection from the controller for 15 seconds and then reconnect.

NOTE: Resetting the unit via the front panel will set the network connection to DHCP.  Keep this in mind for units that 
are set to a static IP address.
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5. System Design Considerations
The SmartAudio matrix has different functionality than other Savant audio switchers.  When designing s system, be sure 
and follow these guidelines in order for the system to function as intend once configured and installed.

• Unlike Savant Pro Switchers, multiple outputs on the SSA-3220/SSA-3220D cannot be combined into a 
single zone to support multiple speakers.  Outputs on the SSA-3220/SSA-3220D are designed to be a single 
zone only.

• A 2ch PCM signal is required on digital inputs when using the Down-mixing pass-through option.  All signals will 
produce no output when this option is selected. 
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6. Control Wiring Terminations
6.1. RS-232 Connections
The RS-232 control port located in the lower right corner on the rear of the unit is used to communicate with the matrix 
via a computer or 3rd party control system.

Wiring for this port follows the Savant standard where pin 5 is RXD (Receive), pin 6 is TXD (Transmit), and pin 4 is GND 
(Ground).  The diagram below shows the wiring for the Savant side, the opposite side pins will vary based on the device 
being connected to.

 IMPORTANT! When using an RJ45 to DB9 adapter, the cable from the adapter to the SmartAudio should be a 
straight through cable.  Any required crossover should be achieved by using a Null adapter.

6.1.1. RJ45 to DB9 Adapters
Savant uses RJ45 connectors for RS-232, other manufacturers control systems may use the standard DB9.  To make 
connection easy, Savant offers RJ45 to DB9 adapters in a variety of configurations that can be used to connect to 
SmartAudio for RS-232 control.  Be sure and choose the adapter that provides a proper connection to the control 
systems RS-232 port.  Refer to the manufacturers support for the control systems configuration.

For more information on Savant RJ45 to DB9 adapters, see App Note RS-232 Conversion to DB-9 and RS-422/485 
Serial Communication Pinout on dealers.SavantSystems.com.

 IMPORTANT! If you are using RJ-45 to DB-9 adapters not supplied by Savant:

• Ensure that any wires required for communication/control are terminated within the adapter.
• Ensure that all wires NOT required for communication/control are NOT terminated in the connecter.
• Ensure that the unused wires in the connector are cut to prevent them shorting out, as they are still terminated in 

the RJ-45 connector on the controller side

6.2. Network (LAN) Wiring
Wiring for Network LAN connections follow the EIA 568B standard:

Pin 1: White/Orange

Pin 2: Orange

Pin 3: White/Green

Pin 4: Blue

Pin 5: White/Blue

Pin 6: Green

Pin 7: White/Brown

Pin 8: Brown

Pin 1
Pin 8

RJ45 Connector
(Gold Pins Facing Up)
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7. Deploying SmartAudio
This section requires the use of RacePoint Blueprint for layout of the system so that control can be established and UIs 
created.  While you have used Blueprint before, it is a good idea to review the basic actions that will be used during the 
deployment process.  See Appendix A - Blueprint Basics for a refresher on Blueprint basics.

 IMPORTANT! Deploying a SmartAudio matrix within a Savant system is different than other Savant components.  
Follow all instructions, and warnings carefully to ensure a successful deployment of SmartAudio.

7.1. Add the System Backbone (Savant Controller and Switching)
1. Create the rooms for the system

To make placement of components a smooth and quick process, we recommend that all rooms be created as a first 
step.  This will allow for components to be placed in the rooms as they are added to the layout.

2. Add a Savant Controller to the Layout
The SmartAudio matrix does not contain connections for the control of other devices.  If any IR or RS-232 controlled 
devices exist in the layout, a Savant controller must be added to the configuration.

Tip: If the SmartAudio matrix is the only switching component in the system, choose a controller that does not 
have any switching that would add unnecessary overhead.

Tip: Select a controller that has sufficient control connections for all the components in the system.  This will 
eliminate the need to add controllers for more connections.

3. Add the SmartAudio Matrix to the Layout
Note: The SmartAudio matrix can be controlled via RS-232, however UID control via the LAN connection is the 

preferred method within a Savant system as it allows access that is not available via RS-232.  See section 6 
SmartAudio Web UI for more information.
While not shown in BP, the LAN must be physically connected to a switch.

3.A. Select the appropriate matrix in the Component Library based on the need for output channel delay.
SSA-3220 No Delay
SSA-3220D Adjustable Delay

3.B. Enter the UID for the matrix by selecting the matrix in the config, and opening the inspector.
Toolbar: View > Show Inspector

Note: The inspector must be closed from the previous step, and reopened for the matrix in order for the Savant ID 
box to appear.

4. Add an Amplifier to the Layout
The SmartAudio matrix connects to an amplifier (or Powered Speakers) to send audio to the speakers.  Up to 8 
stereo pairs can be connected to the SmartAudio matrix.
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Additionally, 4 digital audio outputs are provided for connection to AV Receivers, DACs, or any other device with a 
digital coax input.

5. Connect the Audio Outputs to the appropriate amplifier, or powered speaker.
Note:

Unlike Savant Pro Switchers, multiple outputs on the SSA-3220/SSA-3220D cannot be combined into a single zone 
to support multiple speakers.  Outputs on the SSA-3220/SSA-3220D are designed to be a single zone only.

6. Add Control Devices to the Layout
Place the Savant remotes, iPads, and iPods that will be used for control on the layout in the appropriate room.

 IMPORTANT! The SSA-3220 and SSA-3220D graphic equalizer can only be used on user interfaces with the 
following themes.  The EQ will not be visible using any theme not listed below.

• iPad Retina
• Touch1
• Touch Remote1

7.2. Configuring Digital Inputs
Digital inputs on the SmartAudio matrix can be connected to either digital coax, or optical (Toslink) sources.  These 
inputs numbered 17 to 32, are configured to provide 12 coax, and 4 optical.  Inputs 17 to 28 are configurable within 
Blueprint should the source connections require more optical inputs. 

Follow these steps to configure inputs 17 to 28:

1. Select the SmartAudio matrix within the Blueprint configuration, and open the Inspector.
Toolbar: Tools>Show Inspector

2. On the Device tab, next to Show, select Slots.

3. Select the slot to change and press Delete (Backspace on Windows keyboard).

4. Verify Delete in the open dialog

5. In the right view pane, select the desired input type under modules, and drag onto the open slot.
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6. Repeat steps 3 through 5 for all inputs that require reconfiguring.
NOTE: Changes to input type will not appear in the web UI until a service that uses the reconfigured slot has been 

activated.

7.3. Add the AV Sources
While the SSA-3220 can be used with sources connected directly, it may also be used with a SmartLink matrix switch 
utilizing the digital audio outputs.  Adding this to the system will expand the capabilities of the system allowing for the 
highest level of flexibility.

For details on deploying the SmartLink matrix, see the SmartLink Blueprint Deployment Guide found on 
dealers.SavantSystems.com.

Tip: If a SmartLink matrix is being used, sources for the system may be connected to the SmartLink matrix and will 
not require connection to the SmartAudio matrix.  Be sure and plan out source routing before making any source 
connections.

Note: Digital inputs 17 to 28 can be configured for either digital coax or optical.  See Configuring Digital Inputs before 
making any digital input connections.

1. Place the source onto the layout, and select the appropriate room.

2. Connect the Audio output of the source to the an Audio input on the SmartAudio matrix.

3. Connect control for the source to the appropriate type of connection on the controller.

4. Repeat steps 1 to 3 for all sources in the system.
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7.4. Add the Speakers
While we have included the addition of speakers to this guide, the choice of speakers and amplifier will determine how 
they are deployed within the system.  Refer to the documentation for the speakers and amplifier used for details on 
connecting while adding speakers.

1. Place the speakers onto the layout, and select the appropriate room.

2. Connect the Audio input of the speaker to an output from the SSA or the amplifier.

3. Repeat steps 1 to 3 for all speakers in the system.

7.5. Add Other Devices to the Layout
Now that the necessary items for the SmartAudio matrix have been added to the layout, other devices can be added 
and configured per their documentation.

7.6. Configuring Zones and I/O Assignments
While SmartAudio can be operated with default settings, I/O assignments and zones can be configured to bring added 
functionality to the system.

7.6.1. Enabling or Disabling Zones
By default, all zones are enabled, use the steps below to limit the zones an output will appear in.

1. Select the SmartAudio switch in the Blueprint layout.

2. Open the inspector.
Toolbar: View > Show Inspector

3. In the Show drop-down, select Enabled in Zones.

4. Uncheck the box next to the zone to disable the switch in.
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7.6.2. Assigning I/Os
In addition to assigning zones, inputs can be configured to appear only on certain outputs.  This is useful to limit access 
to a source that may not be desired to be accessible from all zones.

1. Select the SmartAudio switch in the Blueprint layout

1.A. Open the inspector
Toolbar: View > Show Inspector

1.B. In the Show drop-down, select Allowed I/O Paths

2. Under each output, uncheck the box for the input that is not desired to appear.
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8. SmartAudio Web UI
In addition to Blueprint, SmartAudio may also be configured via a built in web UI.  Through the web UI the IP address, 
zone, and I/O assignments can be configured.

8.1. Accessing the Web UI
In order to access the web UI, the IP address of the SmartAudio switch is needed.  To retrieve the IP address of the 
switch, follow the steps in Appendix B.

1. On the master host, open Safari and enter the address of the switch in the address bar:
Syntax: http://[IP Address of Switch]
Example: http://10.5.196.42

2. Once opened, login credentials will be required.
User: RPM
Password: RPM
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8.2. SmartAudio Status

A. Savant ID
UID of the SmartAudio Matrix

B. IP Address
Currently assigned IP address

C. Firmware Version
Current firmware version

D. FPGA Version
Current FPGA version

E. Uptime
Amount of time unit has been powered on without a restart.

F. Restart
Select to restart the matrix

8.3. Network Configuration

A. IP Address Configuration
DHCP or Static.

B. IP Address
Displays the current IP address and allows for entry.  This is automatically assigned when item A is set to DHCP.

C. Subnet Mask
Subnet mask of the network.  This is automatically assigned when item A is set to DHCP.

D. Router
IP address of the network router.  This is also known as Gateway or Default Gateway
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E. Revert
Press to erase entered settings and revert back to saved settings.

F. Apply & Restart
Press to apply entered settings, and restart the matrix.

8.4. SmartAudio Operation Logs

A. Log Level Shown
Selection of type of log to view.

Logs are separated into levels based on the severity of the event.

Log Level Description

Emergency A severe condition that requires an immediate system 
restart. This system is probably not functioning at all.

Alert A severe condition that requires an immediate system 
restart. This system is probably not functioning at all.

Critical A condition that indicates that the system is probably only 
partially functional due to some failure.

Error Something didn't work. The system may not have been 
able to complete a request or task.

Warning Unusual condition. Something unexpected or bad 
happened, but the system is fine.

Notice Normal, but significant conditions occurred.

Info Informational events. Indicates normal operational events.

B. Log Display Area
Displays the the selected log information.
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8.5. Firmware Updates

A. Current Firmware version

B. Server Address
Address of the tftp server containing the firmware update file

C. Filename
Name of the firmware file to load

D. Update Firmware
Select to update the matrix firmware

E. Current FPGA version

F. Server Address
Address of the tftp server containing the FPGA update file

G. Filename:
Name of the FPGA file to load

H. Update FPGA
Select to update the matrix FPGA

For details on how to update firmware, see section 8 Updating Firmware.

Savant® SmartAudio Matrix Switch Blueprint Deployment GuideSavant® SmartAudio Matrix Switch Blueprint Deployment GuideSavant® SmartAudio Matrix Switch Blueprint Deployment GuideSavant® SmartAudio Matrix Switch Blueprint Deployment GuideSavant® SmartAudio Matrix Switch Blueprint Deployment GuideSavant® SmartAudio Matrix Switch Blueprint Deployment Guide
009-1067-03 140806 20 of 30



8.6. Input & Output Configuration

A. Digital Signal Type (Digital Inputs Only)
Display the digital signal type (PCM or Encoded).

B. Connector Type
Analog Inputs: Stereo RCA

Digital Inputs: Selectable Coaxial or Toslink (Inputs 29 to 32 are Coaxial Only)

C. Channel Trim
Adjusts the gain of the input from -10 dB to +10 dB

D. Input List

E. I/O Connection Indicator
When an input is connected to an output, a line will appear between them showing that there is a connection.  
Inputs with no connection will have a black dot with no line.

The dots can also the used to connect an input to an output. Simply click & hold the mouse on the dot next to the 
desired input, and drag the line to desired output dot, and release.

F. Output List

G. Output Channels
Stereo or Mono

H. Down-mixing
Note:

A 2ch PCM signal is required on digital inputs when using the Down-mixing pass-through option.  All signals will 
produce no output when this option is selected.

Process: Enables Delay, Volume, and Mute
Pass-Through: Disables Delay, Volume, and Mute
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I. Channel Delay (Analog Inputs on the SSA-3220D Only)
Adjustable delay per analog channel from 0 - 85ms

J. Volume Level
Adjusts the output level of the channel from + 10 dB to -117 dB in 0.5 dB increments, or mutes audio.
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9. Updating Firmware
Follow the procedures below to update the chassis firmware, and FPGA.

IMPORTANT! Prior to da Vinci 5.2.3 matrix profiles in Blueprint did not have a UID entry field.   Any chassis ,and 
host running da Vinci 5.2.3, or higher with a UID assigned in Blueprint does not require this procedure as firmware 
and FPGA is updated automatically.

Note: To perform these procedures you will need to know IP address of the Master Host, and the Switch.  Gather this 
information and have it on hand before performing the procedure below.

9.1. Setting Up the TFTP Server
1. Download the chassis firmware, or FPGA from www.SavantSystems.com

2. Access the master Host via Remote Desktop:

2.A. From the SDE, select Spotlight  on the Mac OS X bar in the upper right hand corner.
Enter: Remote Desktop, and then select it in the drop-down list.

2.B. Select the master host and login.

3. Copy the .bin file to the master host:

3.A. On the master host Select: Finder > Go > Go to Folder

3.B. Enter in /tftpboot and select GO.

3.C. Copy the Firmware, and FPGA update files from the SDE to the tftpboot folder on the Host.
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9.2. Updating Chassis Firmware
1. Setup the TFTP server following the steps in Setting Up the TFTP Server.

2. Access the matrixes Web UI following the steps outlined in Accessing the Web UI.

3. Select Firmware from the left side navigation menu.

4. Under Current Firmware on the right hand side, enter the following:
TFTP Server IP Address: [Master Host IP Address]
Firmware File Name: [Name of the .bin Firmware File]

Example: ”uImageR3Flash<date>_7_11_xxx.bin” 

5. Select Update Firmware
Upon completion an In Process screen should appear within 5 to 10 seconds. After an Upgrade Complete 
notification appears, follow the prompts.

Note: If a countdown is not displayed please reboot manually.

6. Repeat steps 1 -5 for FPGA using the Current FPGA section and selecting the .mcs file.
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Appendix A: Blueprint Basics
Note: The following steps assume that a blank project is open within Blueprint and has been omitted as a step.

Creating Rooms
When a new project is started, a room is created with the name Room 1.  Change the name to one of the rooms in the 
system before adding more rooms.

1. Click the plus at the bottom of the left hand room list.

2. Enter a name for the room, and a room type.

User: • Room (Zone) contains an end-point to control.
• Sources placed in user rooms are controllable only from that room.
• Room (Zone) is selectable for control on UIs.

Global: • Room (Zone) does not contain an end-point to control.
• Sources placed in global rooms are controllable from any room.
• Room (Zone) is not selectable for control on UIs.

Adding Components
1. Open the Component library.

Toolbar: View> Show Component Library

2. Use the Component Type, Control Type, and manufacturer selection boxes to locate the component, or use the 
search box to locate by manufacturer or model number.

3. Select the component from the list and drag onto the layout.
If a room selection box appears, select the room to place the component into.
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Viewing / Editing Component Parameters
1. Select the component under the room, or in the layout.

2. Open the Inspector to view the parameters.
Toolbar: View> Show Inspector

Connecting Components
1. Expand the components connection list by clicking on the green circle button at the top of the component in the 

layout.

2. Right click on a connector, and select a connector to connect to from the drop down list on the appropriate 
component.

Note: Only connections that can be made will appear.  Different type, or already occupied connections will not be 
shown.
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Appendix B: Retrieving and Setting IP Address
The release of the Savant Application Manager with da Vinci 5.2.2, how the rpmEmbscanner is accessed varies based 
on the method used to install Blueprint on the Savant Development Environment (SDE).  Follow the steps below based 
on the method used to install Blueprint.

Note: You will need to know the UID of the unit in order to retrieve the IP address.  Record the UID from the sticker 
located on the rear of the unit before performing the steps below.

 IMPORTANT! The SDE must be connected to the same network as the Savant system in order to for the devices 
to appear in the rpmEmbscanner.  Ensure that the SDE and system are connected to the same network before 
proceeding.

Installed on SDE using Runtime Package
1. On the SDE, select Spotlight on the Mac OS X bar in the upper right hand corner.

2. Enter: rpmEmbscanner, and then select it in the drop-down list.

3. Select the device to edit in the list, and click Edit.

Select the device to Edit

Click Edit

4. In the open settings tray, set Configure to Manually, enter the IP address, and press the tab key.  The Subnet 
Mask, and Router will populate automatically.

Set Configure to Manually
Enter IP Address

Click Save & Reboot

5. Click Save & Reboot. After a short period of time, the controller will come back online with the new IP Address.
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Installed on SDE using Savant Application Manager (SAM)
1. On the SDE open the Savant Application Manager.

2. In the list of available da Vinci versions, select the version that matches the Blueprint configuration running on the 
host.  Select Activate to make it the active version.

Note: If the version running on the host is not in the list, see the  SAM Deployment Guide for information on how to 
install it before proceeding.

3. Open the rpmEmbscanner using the toolbar:
Launch>rpmEmbscanner

4. Select the device to edit in the list, and click Edit.

Select the device to Edit

Click Edit

5. In the open settings tray, set Configure to Manually, enter the IP address, and press the tab key.  The Subnet 
Mask, and Router will populate automatically.

Set Configure to 
Enter IP Address

Click Save & Reboot

6. Click Save & Reboot. After a short period of time, the controller will come back online with the new IP Address.
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Appendix C: Document Revision History
009-1067-03 - August 2014
Section Update

3.2 Added analog output to specifications table

5 New section: System Design Considerations

7 Added note to step 5 regarding not being able to combine outputs like on Pro Switchers.

8.6 Added note regarding the requirement of 2ch PCM on digital inputs when selecting pass-
through.

Appendix C Added section to list Document Revision History
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Important Notice
Disclaimer
The contents of this document are subject to change without notice; therefore, the information presented herein shall not 
be construed as a commitment or warranty. 

Savant Systems, LLC shall not be liable for any technical or editorial errors or omissions contained herein or for incidental 
or consequential damages resulting from the performance, furnishing, reliance on, or use of this material.

Patents
Certain equipment and software described in this document is protected by issued and pending U.S. and foreign patents.  

All products and services are trademarks or registered trademarks of their respective manufacturer. 

Copyright
This document contains confidential and proprietary information protected by copyright. All rights reserved. Copying or 
other reproduction of all or parts of this document is prohibited without the permission of Savant Systems.

Trademarks
RacePoint Blueprint™, NOW YOU CAN™, and SAVANT® are trademarks of Savant Systems, LLC.
Adobe® Photoshop® is a trademark of Adobe Systems Incorporated
AirPlay®, Apple®, AirPort Express®, AirPort Extreme®, Apple TV®, Apple Remote Desktop™, FireWire®, iMac®, iTunes®, 
iPad®, iPad® mini, iPhone®, iPod touch®, MacBook®, Mac® and OS X® are trademarks or trade names of Apple Inc., 
registered in the U.S. and other countries.
Dolby® and the double-D symbol are registered trademarks of Dolby® Laboratories.
DTS is a registered trademark and the DTS logos and symbols are trademarks of DTS, Inc.

All brand names, product names and trademarks are the property of their respective owners.

Technical Support 
Savant Systems LLC is dedicated to providing prompt and effective support.
To do this in a timely and efficient manner:
1. Access the Savant Portal
2. Enter your E-mail Address and Password. 
3. Read the Terms and Conditions statement. 
4. Select the check box to accept the Terms and Conditions.
5. Click Login.
6. The Savant Portal and Support Center Web page opens.
7. Select Support Request box.
8. The Submit a Ticket window opens.
9. Complete the information and click Finish.

Sales
Savant Systems LLC is dedicated to providing prompt and effective sales support.
Visit  Savant Systems.com to locate a local sales representative in your area.
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